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Note to the Author

This template has been provided by the Georgia Technology Authority Enterprise Portfolio Management Office.  Questions should be directed to epmo@gta.ga.gov

[This document is a template of a Deliverable Management Plan document for a project. The template includes instructions to the author, boilerplate text, and fields that should be replaced with the values specific to the project.

· Blue italicized text enclosed in square brackets ([text]) provides instructions to the document author, or describes the intent, assumptions and context for content included in this document.

· Blue italicized text enclosed in angle brackets (<text>) indicates a field that should be replaced with information specific to a particular project.

· Text and tables in black are provided as boilerplate examples of wording and formats that may be used or modified as appropriate to a specific project.  These are offered only as suggestions to assist in developing project documents; they are not mandatory formats.

When using this template for your project document, it is recommended that you follow these steps:
1. Replace all text enclosed in angle brackets (e.g., <Project Name>) with the correct field values. These angle brackets appear in both the body of the document and in headers and footers.  To customize fields in Microsoft Word (which display a gray background when selected):
a. Select File>Properties>Summary and fill in the Title field with the Document Name and the Subject field with the Project Name.  
b. Select File>Properties>Custom and fill in the Last Modified, Status, and Version fields with the appropriate information for this document. 
c. After you click OK to close the dialog box, update the fields throughout the document with these values by selecting Edit>Select All (or Ctrl-A) and pressing F9.  Or you can update an individual field by clicking on it and pressing F9. This must be done separately for Headers and Footers.
2. Modify boilerplate text as appropriate to the specific project. 
3. To add any new sections to the document, ensure that the appropriate header and body text styles are maintained.  Styles used for the Section Headings are Heading 1, Heading 2 and Heading 3.  Style used for boilerplate text is Body Text.
4. To update the Table of Contents, right-click and select “Update field” and choose the option- “Update entire table”
5. Before submission of the first draft of this document, delete this “Notes to the Author” page and all instructions to the author, which appear throughout the document as blue italicized text enclosed in square brackets.
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[bookmark: _Toc393473859][bookmark: _Toc393611257][bookmark: _Toc393841955][bookmark: _Toc394792145][bookmark: _Toc382839906]Introduction
[bookmark: _Toc382839907]Purpose
This document is the Deliverable Management Plan for the <Project Name> Project. The purpose of the plan is to facilitate the timely review of project deliverables; to ensure deliverables are tracked and all events are recorded; and to ensure a copy of each deliverable and all supporting materials are filed in the project library.  Deliverable management is necessary to ensure the state only accepts deliverables that meet project or contract requirements and contractors are only paid for acceptable deliverables. 

[In most cases, the Deliverable Management Plan will be created during the Planning life cycle phase, and could become an appendix to the Contract Management Plan.] 
 
[bookmark: _Toc382839908]Scope
This Deliverable Management Plan identifies the procedures used to coordinate the review and approval of project deliverables. In addition to documenting the approach to deliverable review and approval, the process covers who participates in deliverable tracking and the tools used to track the progress of the deliverable. 

This process assumes the deliverable has been reviewed and approved through various project staff, users and stakeholders to ensure their needs will be met. Thus when this process is invoked, the deliverable should be complete and ready for signature. Reviews of early drafts are encouraged to ensure a smooth and timely final review. 

[bookmark: _Toc382839909]Acronyms and Glossary

[This section should contain any acronyms or terms that are specific to the project or business represented to ensure that all readers are using the same definitions.  If preferred, this section could refer to the Project Glossary within the Project Charter or other document].

[bookmark: _Toc189380078][bookmark: _Toc193265449][bookmark: _Toc382839910]Document Maintenance
This document will be reviewed <insert frequency> and updated as needed. This document contains a revision history log. When changes occur, the document’s revision history log will reflect an updated version number/date, the owner making the change, and the change description will be recorded in the revision history log of the document. 

[bookmark: _Toc80155626][bookmark: _Toc382839911]Participants Roles and Responsibilities
[The focus is on the roles for the process, not overall roles for the project. Discuss who has the authority to approve or reject deliverables and any required reviewers. Discuss who leads the review and who tracks the review progress. If appropriate, refer to an appendix or separate table which shows the reviewers for different types of deliverables. At a minimum, the Business Owner and Project Manager should review all vendor deliverables.]  

[bookmark: _Toc382839912]Project Sponsor
The Project Sponsor is ultimately responsible for the final decision on all project issues.

[Per PMI, this will generally be the Project Sponsor, but it may be delegated to the Business Owner or Steering Committee Chairperson in some instances.]

[bookmark: _Toc382839913]<Insert Role>
The <Insert Role> is the final authority in the approval of all prime contractor deliverables. The <Insert Role> must be a state employee.

[bookmark: _Toc382839914]<Insert Role>
The <Insert Role>coordinates the review of the deliverables, in cooperation with the Functional Manager(s). The Contract Manager is responsible for ensuring the deliverable is reviewed against the contractual requirements and any agreements made with the vendor.  The Contract Manager recommends approval or rejection, provides feedback to the contractor, and updates < Project Manager > with periodic status. The results of deliverable reviews are used in other contract management processes, including invoice approvals. 

[bookmark: _Toc382839915]Functional Managers/Leads 
The functional managers/leads ensure the assigned deliverable is reviewed from a requirements perspective, compiling responses from other reviewers, as necessary. The Functional Manager works with the Contract Manager to determine if the deliverable should be accepted or rejected based on the results of the review.

[bookmark: _Toc80155631][bookmark: _Toc382839916]Deliverable Management Process Approach
The deliverable management process consists of five steps.
Receive Deliverable
Prepare and Route Deliverable
Functional Review of Deliverable
Project Manager Review of Deliverable
Closing a Deliverable after Approval 

[bookmark: _Toc80090069]Figure 1. Deliverable Management Process Flow Chart

< insert chart here >

[Each contract and/or Project Charter specifies the number of hard copy deliverables that must be provided along with any other delivery requirements (e.g. the vendor must also deliver one electronic copy of each deliverable). In the event of a conflict, the information contained in the contract takes precedence over the information in this document.]


[bookmark: _Toc80155632][bookmark: _Toc382839917]Receive Deliverable
[The deliverable due date and actual submission date must be tracked for historical purposes. 
Indicate if a Deliverable Transmittal Sheet (DTS) will be used and where it may be obtained. Indicate if there are different DTS templates for the project team and vendor deliverables. Indicate where any delivered media is stored. 
Discuss required deadlines for process steps and any metrics or quality measures which are collected or initiated for this process.] 

[bookmark: _Toc203037663][bookmark: _Toc203037664][bookmark: _Toc203037665][bookmark: _Toc80155633][bookmark: _Toc382839918]Prepare and Route Deliverable
[Discuss the actions required to prepare the deliverable for review. Indicate who gathers the materials and submits the information to the reviewers. Indicate how the deliverable is prepared and routed (e.g., by email, by fax, in paper folders, etc.). Indicate if the review is sequential or simultaneous. Indicate if there are draft and final reviews or only a single review (the template included in this Plan currently provides for a single review). 
Discuss how and where the reviewers are identified and documented. Indicate who determines if sponsor, user or other stakeholders need to participate in reviews and who coordinates their inclusion in the review. 
Discuss required documentation and how the action item is updated with status. Discuss required deadlines for process steps and any metrics or quality measures which are collected.]


[bookmark: _Toc203037667][bookmark: _Toc203037668][bookmark: _Toc203037669][bookmark: _Toc203037670][bookmark: _Toc80155634][bookmark: _Toc382839919]Functional Review of Deliverable
[If appropriate, this section may be split into subsections describing project team and vendor(s) deliverable reviews. 

Discuss the criteria and requirements used to review the deliverable. At a minimum, the review should consider the Deliverables Expectation Document (if applicable), any applicable contract requirements, and industry standards, as well as adherence to mandated templates or state formats. Where applicable, pre-defined acceptance criteria should be referenced and used in the review. Other general quality requirements may be included such as completeness of discussion, clarity of discussion, and consistency with other already delivered items. 

Discuss how the review is performed (e.g., individually or group walkthrough) and who leads the review (usually the Contract or Functional Manager). Indicate if any of the reviewers are considered mandatory and if comments must be received from all reviewers (or a subset of key reviewers) before the process can proceed.

If outside participants (e.g., sponsor, users, stakeholders) are included in the review, indicate any special coordination or required responses to their comments. Also indicate if they participate in the decision to approve or reject the deliverable. 

Indicate how comments are consolidated and documented. Indicate who makes the recommendation to accept or reject the deliverable, and who participates in the recommendation decision. 

Discuss required documentation, such as approval or rejection letters, and how the action item is updated with status. Discuss required deadlines for process steps and any metrics or quality measures which are collected.]


[bookmark: _Toc80155635][bookmark: _Toc382839920]Project Manager Review of Deliverable
[If appropriate, this section may be split into subsections describing project team and vendor(s) deliverable reviews
. 
Discuss the criteria used in the Project Manager’s review, if different from the functional review. Discuss how the review is performed (e.g., individually or through a meeting with the Contract and Functional Managers and/or vendor). Indicate if the Project Manager must consider the Sponsor, User or Stakeholder recommendations in conjunction with the Contract and Functional Managers’ recommendation. 
If the Project Manager has additional comments, indicate how the comments are documented and how this affects the decisions to reject or accept. Indicate if a conditional acceptance is allowed (and what conditional acceptance means[footnoteRef:1]) or if the only choices are accept or reject. Discuss what happens if the Project Manager disagrees with the Contract and Functional Managers’ recommendation.  [1:  Conditional acceptance should only be used for minor corrections. For conditional acceptance, the vendor must make the corrections or provide the additional materials and resubmit the document. In these cases, the deliverable does not necessarily go through a full review again. Sometimes the Functional Manager performs a review of the corrections and a spot check of the remaining document to ensure no other errors were introduced. The deliverable is not considered closed until the corrections are made. Often the contractor has only a limited amount of time to make the corrections or the deliverable may be considered rejection. ] 

Generally the Project Manager has the ultimate authority to approve deliverables within set parameters such as cost or project impact. This is preferable when possible to limit the amount routing and waiting for other signatures. In some cases, it may be necessary to obtain the sponsor’s signature on key vendor deliverables. If this signature is delayed, attempt to obtain an informal or e-mail approval to allow vendor notification and to avoid impacting the schedule. 
Discuss how the vendor(s) is notified of the deliverable decision and any follow-up or required next steps required of the vendor. 
Discuss required documentation, such as approval or rejection letters, and how the action item is updated with status. Discuss required deadlines for process steps and any metrics or quality measures which are collected.] 

[bookmark: _Toc80155636][bookmark: _Toc382839921]Closing a Deliverable after Approval
[Discuss the actions required to close the deliverable and end the review. Discuss how the action item and contract-tracking database are updated both if the deliverable is accepted and if it is rejected. The approval (or rejection date) must be recorded in the contract tracking tool for historical purposes. 

Indicate which materials from the review (e.g., DTS, e-mail regarding comments, comment forms, etc.) are retained in the project repository or library. At a minimum a copy of any signed correspondence must be retained. 

E-mail should not be used for formal communication of deliverable rejection, but may be used as an informal early response if followed by formal correspondence. Formal letters of acceptance and rejection are required for prime contractor deliverables. A formal letter of rejection is also required for consultant deliverables.  

Discuss any required distributions or postings regarding the acceptance and availability of the deliverable. It is preferable to make the document available electronically than to distribute paper copies. 

Discuss how process metrics and quality measures are collected, analyzed and who they are forwarded to for trend analysis. Discuss how often metrics are reported and to whom.] 
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[bookmark: _Toc382839922]
SAMPLE Deliverable Transmittal Sheets
SAMPLE Vendor Deliverable Transmittal Sheet
	Contractor Deliverable Information to be completed by Contractor

	Date Deliverable Presented for Acceptance: 


	Deliverable Title:
	Deliverable #:

	Deliverable Due Date (per work plan):
	Contact person(s):
	Deliverable Status:

[bookmark: Check1][bookmark: Check2]DED |_|   Final  |_|

	Date(s) Delivered to Project Office:
  -  Hardcopies:

  -  Electronic (soft) copy:
	Electronic Copy:
[bookmark: Check3]|_|  Disk/CD/DVD Attached  

[bookmark: Check4]|_|  File e-mailed to:  

	Project Librarian

	Date Deliverable Received:
  -  Hardcopies:

  -  Electronic (soft) copy:
	Received by:
	Worksite Document Number:  
	Worksite number(s) of related documents: 

	Functional Manager
  -  Name:
  -  Functional Area:
	Date Sent to Functional Manager:
	MTS Updated?

[bookmark: Check5][bookmark: Check6]|_|  Yes       |_|  No

	Sponsor Approval

	
[bookmark: Check7][bookmark: Check8]Sponsor Approval Required?   |_|   No     |_|  Yes  -  If yes, Name of approver:  


	[bookmark: Check9][bookmark: Check10]Project Recommends Approval: |_|  No  |_|  Yes
	Comments:


	Date Sent for Approval:

	Sponsor Approval:  (Date)

[bookmark: Check11][bookmark: Check12]|_|  Approved    |_|  Disapproved
	Reason for Disapproval:  
	Sponsor Signature:

	Additional Reviewers

	Comments and this transmittal package are to be returned to the Functional Manager no later than the date indicated:

	

Due Date
	

Reviewer                                                                           Name
	
Worksite # of comments documents.

	
	[bookmark: Check13]|_|  Quality Assurance (2 copies):
	

	
	[bookmark: Check14]|_|  Operations Manager:
	

	
	[bookmark: Check15]|_|  PMO Manager:
	

	
	[bookmark: Check16]|_|  System Architect:
	

	
	[bookmark: Check17]|_|  Program Liaison:
	

	
	[bookmark: Check18]|_|  Implementation Manager:
	

	
	[bookmark: Check19]|_|  Legal:
	

	
	[bookmark: Check20]|_|  (Other):
	

	
	[bookmark: Check21]|_|  CDSS:  
	

	Functional Manager Review

	
[bookmark: Check22][bookmark: Check23]Did Deliverable meet contractual requirements?  |_|  Yes   |_|  No

	Functional Manager Recommendation:

[bookmark: Check24][bookmark: Check25]|_|  Approval    |_|  Disapproval

	Comments:  



	Functional Manager Signature:

	Date:

	MTS Updated?

|_|  Yes       |_|  No

	Before forwarding to Project Director, does this package contain:
[bookmark: Check26][bookmark: Check27]|_|  Copy of Deliverable?    |_|  Copies of all supporting documentation (email, comments, etc.)

[bookmark: Check28]|_|  Draft letter of notification of approval/disapproval for project director’s signature
	Date sent to Project Director:

	Project Director Review

	[bookmark: Check29]|_|  Approved
[bookmark: Check30]|_|  Disapproved
	Signature:
	Date:
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SAMPLE Vendor Deliverable Transmittal Sheet

	Contractor Deliverable Information – (to be completed by the Contractor)

	Due Date of Deliverable:



	Type of Deliverable:

|_|  Formal       |_|  Ad Hoc
	Date Delivered to Project Office:

|_| Mailed       |_|Hand carried
	Purchase Order Number:

	Contractor Name:


	Deliverable Author(s):
	Statement of Work Deliverable Number:


	Deliverable Title


	Brief Description of Deliverable:  

	# of Pages:
	Deliverable Status:
|_| Draft    |_|  Final
	Electronic Copy:
|_|  Disk/CD/DVD attached
|_|  File e-mailed to:


	

	Project Librarian

	Date Received:

	Received by:
	Related Worksite Document #’s:
	MTS Updated:

|_|  Yes    |_|  No

	Assigned Functional Manager:
	Date sent to Functional Manager:  


	MTS Number:
	Comments: 


	Functional Manager Approval

	Did Deliverable meet contract requirements
|_|  Yes   |_|  No
	If no, return to contractor and resubmit to Project Librarian:  Update MTS
	Date returned to contractor:

|_| N/A  |_| Date:
	MTS Updated:

|_|  Yes    |_|  No

	Comments:  



	Recommend:
|_|  Approval
|_|  Disapproval
	Functional Manager Signature:
	Date:
	MTS Updated:

|_|  Yes    |_|  No

	Other Reviewers (If Applicable)

	Reviewer Name:
	Reviewer Organization:
	Date to Reviewer:



	Comments:


	Recommend:
|_|  Approval
|_|  Disapproval
	Reviewer Signature:
	Date:
	MTS Updated:

|_|  Yes    |_|  No

	State Manager Approval

	Manager Name:
	Manager Organization:
	Date to Manager:



	Comments:


	Recommend:
|_|  Approved
|_|  Disapproved
	Manager Signature:
	Date:
	MTS Updated:

|_|  Yes    |_|  No

	Project Librarian

	Date Closed:
	Initials
	Comments:  
	MTS Entries Verified:

|_|  Yes    |_|  No
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[bookmark: _Toc382839923]SAMPLE Deliverable Comment Form
Deliverable Review Sheet
<Deliverable Name>
<Version Number>
<Deliverable Date>
<Vendor Company>

	No.
	Page
	Reviewer Name
	Issues/Concerns
	Recommendations
	Response

	1. 
	1
	<Insert Name>

	
	<Insert Scope write up>
	

	2.
	
	
	
	
	

	3.
	
	
	
	
	

	4.
	
	
	
	
	

	5.
	
	
	
	
	

	6.
	
	
	
	
	

	7.
	
	
	
	
	

	8.
	
	
	
	
	

	
	
	
	
	
	














	
	<Project Name>
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[bookmark: _Toc382839924]Sample Letter of Deliverable Acceptance
[bookmark: _Toc55205860]Acceptance Letter

Date


To:		< Vendor >
From:		< Project Manager >
Re: 		Acceptance of Deliverable < #XXX, Deliverable Name >


This letter serves as notification that your deliverable < deliverable name and number > has met our agreed upon expectations and is accepted as of < acceptance date >.
< Special instructions or next step specific to the deliverable and/or vendor go here if applicable > 
Please retain a copy of this letter for your records.  Any questions can be directed to < Person Name >, < Contract Manager or Business Owner>.

Thank you for your valued contributions to our joint success,


< Project Manager Name >
< Project Name > Project Manager

















		
	<Project Name>



		
	<Project Name>
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[bookmark: _Toc382839925]Sample Letter of Deliverable Rejection
Rejection Letter

Date


To:		< Contractor >
From:		< Project Manager >
Re: 		Rejection of Deliverable < #XXX, Deliverable Name >


This letter serves as notification that your deliverable < deliverable name and number > has not met our agreed upon expectations and is rejected as of  < rejection date >. You have < xx days/weeks/months > to rectify the defects noted below. 
< Specific reasons for rejection go here. Reference the deliverable comment form as appropriate. >
< Special instructions or next step specific to the deliverable and/or vendor go here. Describe the process to resubmit the corrected deliverable.  > 
Please retain a copy of this letter for your records.  Any questions can be directed to < Person Name >, < Contract Manager or State Administrative Manager >.

Thank you for your valued contributions to our joint success,


< Project Manager Name >
< Project Name > Project Manager
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[bookmark: _Toc382839926]General Deliverable Review Criteria
Deliverable Review Instructions 


The < Project Name >  Project has selected you to review the attached deliverable. The process for reviewing deliverables is simple.  Attached to this folder is the Deliverable Transmittal Sheet which indicates when your review is due to the < next Reviewer / Functional Manager >.  

Please review the attached document for the following criteria:

	Criteria
	Description

	Content
	Ensure that the content is appropriate and meets the intent. Verify the document meets the requirements specified in the contract/Statement of Work and Deliverable Expectation Document (DED), if appropriate. If applicable, verify the document conforms to the specified industry and/or government standards.   

	Correctness
	Ensure the deliverable is technically correct, clear, consistent, and testable or verifiable (if appropriate).  Although typographical errors found during the analysis will be identified, the emphasis of the review is technical issues, not editorial issues.

	Completeness
	Ensure the topic is covered in a comprehensive fashion and no sections are incomplete.



Approval:  If you approve the deliverable, please indicate this by signing the Deliverable Transmittal Form.  If there are minor contingencies upon your approval, please indicate this in the comments section above your signature.

Changes Needed:  If you do not approve the contents of the deliverable, please indicate your comments on the Deliverable Comment Form.  
Using the Comment Form, indicate the Page and Table of Contents (TOC) section number of each issue or concern.  If the matter spans multiple pages, please indicate the page on which it starts and include the extent of the problem in the Issues/Concerns column.  If the comment applies to the document as a whole, put “GENERAL” in the Issues/Concerns column.  Include your name in the Reviewer Name column for each comment you make.
After completing the Deliverable Comment Form, please print the document and include it in the Deliverable Folder for the < next reviewer / Functional Manager to view >. The < Project Name > project encourages collaboration between reviewers during the approval process to ensure deliverables are finalized within the project schedule.

If you have any questions regarding the process please contact < Name >, the < Project Name > Deliverable Monitor at xxx-xxxx.
Thank you for your participation in the < Project Name > Project Deliverable Process. 
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